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1-What is the purpose of the given pseudo-code?   f=1 

i=1; while(1<=n):    

f=f*I; i=i+1;    

 To determine the minimum value in a list    

 To calculate the factorial of a given number    

 To identify prime numbers    

 To sort the number list    

2- Always write a pseudo-code in ___________ manners.    

 Independent    

 Dependent    

 Unambiguous    

 Ambiguous    

3- what is the formal definition of an algorithm?    

 An ordered set of unambiguous steps    

 A sequence of parallel executable steps    

 A random set of steps  An ordered set of ambiguous steps    

4- Computer Fraud and Abuse act passed in?    

 1980    

 1990    

 1988    

 1984    

5- Which one is a Unary Operator?    

 Not    

 OR    

 Equal   And    



 

   

    

  

   

    

6- What does it mean for and Algorithm to be “unambiguous’ according to the formal definition of 

computer Algorithms?    

 It can be executed by any computer    

 The steps have multiple Interpretations    

 The steps are clear and have a unique interpretation    

 It involves parallel processing    

7- Which Keyboard is used in Python convention to announce the title of a pseudo-code unit 

representing a program unit?    

 Subprogram    

 Def    

 Module    

 Unit    

8- what is the role of getting your foot in the door in the problem solving process?    

 It guarantees a correct solution    

 It opens the way to extending knowledge    

 It prevents direct confrontation    

 It provides a philosophical perspective    

9- What technique is used by spam filters to distinguish between describe email and spam?    

 Firewalling    

 Learning through a training process    

 Spoofing    

 Proxying    

10- What does the prevention of electronic Crime ordiance2007, in Pakistan aim to address?    

(A)Presentation of electronic crimes    

(B)Cybersecurity education    

(C)International Cooperation    

(D)Wiretapping Regulation    

11- Which mathematician presented loosely defined problem-solving phase in 1945?    

 G. Paimer    



 

   

  G. Pascal    

 G. Pollock    

 G. Polya    

12. What are tree activities involves in the control of a loop structure?    

 Start stop and proceed  

  Initialize, Test Modify   

 Begin, End continue  

 Launch Halt Adjust    

13. Let a unsorted list Fred, Alex, Diana, Byron, Carol so which one will be sorted at the last?    

 Diana    

 Alex    

 Fred    

 Carol    

14- The imperative paragraph also known as the particular machine___    

(A)Procedural paradigms    

(B)Non-traditional paradigms    

(C)Non-procedural paradigms  

(D) Traditional Paradigms     

15- What is the primary goal of the Sequential search algorithms?    

 Randomizing list elements    

 Detecting Duplicate entries    

 Searching for a special target value    

 Sorting a list    

16- How many times will the loop in the example below execute?    

Int counter=1:    

While (counter<=5)    

{    

 Count<<counter;    

Counter=counter+2;    

}    

(A)3 times    

(B)5 times    



 

   

(C)6 times    

(D)4 times    

17- Float CGPA=3.5; if(CGPA>3.0)  count<<’Give Scholarship”; Else   count<<Sorry You do not qualify 

for the Scholarship:”, it  will show    

(A)Sorry You do not qualify for the Scholarship    

(B)Give Scholarship   

(C)Display none    

   

18- If(TargetValue==TestEntry);    

    

In the above condition, what is “==”?    

(A)Assignment Operator    

(B)Expression    

(C)Equal to Operator    

(D)Conditional loop    

19. Why is the initialization step important in loop control?    

(A)It ensures the termination of the looping process    

(B)It compares the current state to the termination condition    

(C) It establishes a starting condition will be modified toward the 

termination condition 

(D) it execute the loo body  

 

 

20- What is the purpose of the provided pseudocode?    

Def Find Max():    

Max=first number in the list    

Current= second number in the list    

While(elements in the list exist)     If(max<current)    

Current= Next Value in the List     

 Finding the average of a list    

 Counting the Number of elements in a list    

 Find the maximum number in the list    

 Sorting a list in ascending order    



 

   

21. What explains the role of the” Take a Sip of tea” in the context of algorithm for making a cup of 

tea and its impact on the overall process?    

(A)It is irrelevant to the tea making algorithm    

(B)It concludes the algorithm    

(C)It adds complexity to the algorithm    

(D)It fetches a new cup    

22- Third Generation language attributes refer to_______   

(A)Particular matchine 

(B)None of these  

(C)For all machine   

(D)For only required machine    

   23-In the provided pseudo code what is the role of the “Current” variable?    

Def Find Max():    

Max=first number in the list    

Current= second number in the list    

While (elements in the list exist)    

If(max<current)    

Current= Next Value in the List    

(A)It indicates the position of the current element in the list    

(B)It stores the current value being compared    

(C)It holds the maximum value in the list    

(D)It represents the minimum value of the list    

22- What is the main characteristic of public key encryption system?    

(A)The use of any random key for encryption and the same key decryption system    

(B)The Use of a Single Key for encryption and decryption    

(C)The use of two keys for encryption and decryption    

(D)Knowledge of encryption allow decryption    

 

 

 

23-What is the Purpose of an Assignment statement in the program?    

(A)To declare the variables    

(B)To assign a value to a variable    



 

   

(C)To request input from the user    

(D)To termination the program    

23- The Binary Search Algorithm uses________    

(A)Quick sort Technique    

(B)Divide and Conquer method    

(C)Linear search    

(D)Bubble sort Technique    

  

24- What does the variable “f” represent in pseudo code?    

f=1 i=1;  while(i<=n):    

f=f*I;  i=i+1;  

The intimal value of loop   

  

(A)The condition for loop termination    

(B)The loop counter    

(C)The factorial of the number    

 

27-A ________ alters the execution sequence of the program    

 Assignment statement    

 control statement    

 Division    

 Modulus    

28- What is a digital signature in the context- key encryption?    

 A mention to decrypted with private key    

 An authentic mark on the message produced with the private key    

 A certificate provided by a trusted authority    

 An encrypted message with public key    

29. In the Java programing language what is the equivalent term for an “activation” in the context 

of concurrent processing?    

(A)Thread    

(B)Operation    

(C)Task    

(D)Function    



 

   

30- In the declarative paradigm, what does a programmer focus on when presented with a 

problem?    

(A)Developing a precise statement of the problem    

(B)Finding a general purpose algorithm    

(C)Describing detailed algorithm    

(D)Developing a sequence of command    

31. __________- is a package containing a party name and public key?    

(A)Contract    

(B)Certificate    

(C)Antivirus    

(D)Security    

32. What would be the next statement? 

 Def Find Max():    

Max=first number in the list    

Current= second number in the list While (elements in 

the list exist)        

 Current=next value in the list    

 Max= Current    

 If(max<current)    

 Max= Value    

33. in the context of the provided pseudocode. What is the purpose of the statement “Count=3” Def   

Greeting ():    

Count=3 while(count>0):  

Print(‘Hello’) count=count-1    

 To define a loop condition    

 To request a service    

 To print a message    

 To initiate a counter    

34- What does the modification step in loop control accomplish?    

 Compares the current state to the termination condition    

 Establishes a starting condition    

 Terminates the loop    

 Moves the condition towards the termination condition    

35 True parallel processing required___________ CPU cores?    



 

   

Single    

None of these    

  

(A)Multiple    

(B)Single    

(C)None of these    

(D)Exact two cores    

36-Which organization have adopted and published standard for popular programing 

language to address the lack of agreement on language definition?  

(A)Complier Writers Association    

(B)   American National Standard institute(ANSI) and international Organization for standard 

(ISO) 

(C)  Programing language 

(D)International Compiler Consortium    



  

 

 

   

37- There are ____ iteration in following pseudo code 

 def Findfactoriala():  fact=2 i=1;    

While(i<=7) fact=fact*I; 

i=i+1;    

5    

 2    

 7    

 3    

38- What might be true about the value of finding a related problem Solving?    

(A)It helps develop general algorithms    

(B)It adds complexity to the current problems    

(C)It is irrelevant to the problem solving approach    

(D)It complicates the solution process    

39. What kind of server works as an intermediate between the client and server?    

 Client server    

 Proxy server    

 Super server    

 Server computer    

40. What condition triggers the termination of the sequential search algorithm as a failure on the 

ordered lists of names?    

 List is empty    

 Equality of TargetValue and TestEntry    

 TestEntry is smaller than TargetValue    

 Reaching a name greater than target name    

41. Which of the following terms refers to the process in which a small request in initially made and 

detail solution in share later?    

(A)Low balling    

(B)High balling    

(C)Foot in the door technique    

(D)Door in the face technique    



    

    
   

  

 

   

42. - Float CGPA=2.5; 

 if(CGPA>3.0)  count<<’Give Scholarship”; 

 Else   count<<Sorry You do not qualify for the Scholarship:”,  

it  will show    

 Sorry You do not qualify for the Scholarship    

 Give Scholarship    

 Display none    

 Good    

43. In the context of a loop structure which part is called the body of loop?    

 The initial condition      

The termination condition    

 The collection of instruction executed repetitively    

 The control process    

44. In the Algorithm representation what does the term ‘syntax” refer to in the context of 

primitives?    

 The complexity of the algorithm    

 The symbolic representation of primitives    

 The level of Detail in Algorithm representation  The meaning of the primitive    

45. For controlling vandalism over network connections a primary prevention technique to filter out 

the traffic passing through a point is    

 Proxy server    

 Firewall    

 Antivirus Software    

 Auditing Software    

46. What is step wise refreshment in algorithm discovery?    

 Conquering on entire task at once    

 Ignoring sub problems    

 Breaking a problem in to sub problems    



    

    
   

  

 

   

 Solving the entire original problem immediately    

47. Which of the semantic structure is used in algorithms for making decisions based on condition?    

 Loop Structure    

 Assignments Statements    

 Iterative structure    

 Selection Structures     

48. What is the key of assigning precise definition to primitives that are used in algorithms 

representation?    

 It removes problems of ambiguity    

 It adds ambiguity to algorithms    

 It complicates algorithms description    

 It increases the level of detail    

  

49. How does the termination condition relate to the while statement in pseudocode?    

It is the condition for modify the loop    

It is the condition for executing the loop body    

 It is the condition for initiating the loop    

 It is the negation of the condition appearing in the whiles structure    

50- While structure starts with checking ____________    

 Iteration    

Value    

 Condition    

 Sequence    

51- What term do computer scientists use to capture the idea of an algorithm being executable?    

 Ambiguous    

 Random    

 Parallel    



    

    
   

  

 

   

 Effective    

52-What approach does the imperative paradigm uses for the programing process?    

 Finding an algorithm and expressing it as a sequence of command    

 Object Oriented Approach    

 Linear Scale development    

 Functional programing approaches     

53.. Let a unsorted list Fred, Alex, Diana, Byron, Carol so which one will be sorted at the first?    

 Diana    

 Alex  

  Fred    

 Carols    

54.How many comparisons to sort the elements using insertion sort algorithm?    

13,10,9,6,33,100    

 5    

 7    

 9    

 3    

55. How is the termination condition loop control?    

 By skipping the test activity    

 By repeating the initialization step    

 By executing the test activity    

 By apply the modification step repeatedly    



    

    

   

  

 

 

56- What might be true about the value of finding a related problem in problem solving?    

 It complicates the solution process    

 It adds complexity to the current Problem    

 It helps develop general algorithms    

 It is irrelevant to the problem solving approach    

57. Which of the following is essential for the representation of an algorithm?    

 Natural Landscapes    

Physical Objects    

 Ambiguous Language    

 Well Defined primitives    

58. what is the primary role of the control process in a loop structure?    

To execute the body of the loop    

To reduce the flexibility of the algorithm    

To avoid stepwise refinement    

To guide the repetition of the loop    

59. How many iterations are required to find 88 in the following Array?    

{5,6,77,88,99}    

 2    

 3    

 4    

 1    

60- The initialization step structure establishes a starting____________    

(A)Condition    

(B)Total number of code line    

(C)Function definition    

(D)Body    



 

 

61- In ___________ paradigm, task of programmer is to loop a precise problem statement rather than 

designing an algorithm for solving the program    

(A)Imperative    

(B)Declarative    

(C)Object oriented    

(D)Functional    

62- Polya’s analysis of problem solving is to evaluate the solution for    

(A)Consistency    

(B)Cost    

(C)Accuracy    

(D)Time    

    

    

    

       



 

 

    

63- In the Context of the provided pseudocode, what is the purpose of the statement Count=Count-1?    

Def Greeting ():    

Count=3 while(count>0):  

Print(‘Hello’) count=count-1    

(A)To decrement the counter    

(B)To print a message    

(C)To reset the counter    

(D)To increment the counter    

64- If while(i<n) the loop will keep executing until ’i’ remains    

(A)Less than N    

(B)Greater than and equal than n    

(C)Less than or equal than n    

(D)Equal to in    

65. Which of the following is the correct Syntax for conditional statement?    

(A)If(condition) Statement A Else Statement B    

(B)If (condition Statement A Else Statement B    

(C)If(condition) Statement A Else Statement B 

(D) If(Condition) 

66. What is the following is true about file flops?    

(A)Produce output in group    

(B)Accept inputs individually    

(C)Generate output individually     

(D)Generate output collectively    

67. What is a correct expression for finding factorial where f=1 , i=1; while(i<=n)?    

(A)F=f*n    

(B)F=f-n    

(C)F=f+n    

(C)F=f2n    

 



 

 

68.In what case both the print statement will be executed in the following code?    

If(marks>60)   

print(You have passed the exam)  

Else    

    Print (You have failed the exam)    

(A)Make are less than or equal to 60    

(B)Marks are greater than 60    

(C)Both cannot be executed at a time    

(D)Marks are less than 60    

69-  What is the significance of the statement f=f*I in each iteration of the loop in the given 

pseudocode?    

. f=1 i=1;    

while(1<=n):    

f=f*I; i=i+1;    

 it has no impact in the loop    

 it multiplies the current value of ‘f’ by loop counter ‘i’    

 it subtracts the loop counter ‘I’ from the current value of ‘f’    

 it reset the value of ‘f’ to 1    

70. What is the primary focus of a programmer in a declarative programing?    

 Developing a precise statement of the problem    

 Describe algorithms    

 Developing problem solving algorithms    

 Writing pseudo code     

 

 

 

71-In what case both the print statement will be executed in the following code?    

Marks=60    

If(marks>50)    

   Print (You have passed the exam)    



 

 

Else    

    Print (You have failed the exam)    

    

(A)You have failed the exam    

(B)You have passed the exam    

(C)No message will display    

(D)Both will display    

72- What is the condition ‘temperature>0’imply in the following pseudo code?    

While (temperature>0):    

Turn on heater     

 Turn on the heater repeat until the condition is false  

  Keep the heater on until the Temperature is greater than 0  

  Turn on the heater once.  

   Skip turning on the heater.    

73-In computer programing what come after the ‘if’ keyword in an if statement?    

 Else    

 Statement B  

  Condition    

 Statement A    

74.What distinguishes the declarative paradigm from the impetrative program in programming?    

 The emphasis on procedural programing    

 The use of pre-established algorithms    

 Developing precise statements of problems    

 Describing Algorithms for problems solving    

 

75-in the context of program development, what is the goal of finding a general algorithm?    

 To develop an algorithm that can solve all instance of a problem    

 To solve a particular instance of a problem    

 To find a specific Solution for each instance    

 To slave a specific problem without decomposition    



 

 

76. SS protocol is the back bone of____________    

 HTML5    

 HTML    

 HTTPR    

 HTTPS    

77. Which of the following is responsible for maintaining the anonymity of the actual client from the 

server over the internet?    

 Routers    

 Proxy Server    

 Spam Filters    

 Firewall    

    

78. In the given example, what does the loop do?    

While (ph level>4):    

Add a drop of sulfuric acid    

 Add a drop of sulfuric acid regardless of the ph level    

 Adds a drop of sulfuric acid if the ph level is greater than 4    

 Adds a drop of sulfuric acid only once    

 Adds a drop of sulfuric acid if the ph level is the less than or equal to 4    

 

79-Under________ paradigm a program is viewed is an entity that accepts inputs and produce 

output.    

 Declarative    

 Imperative 

   Functional    

 Object Oriented    

80-Which of the following is not a relational operator in C++?    

 = =    

 ! =    

 % =    



 

 

 > =    

81-In Pseudocode Algorithm can be represented as:    

 Statics way    

 Dynamic ways    

 Informal way    

 formal Way    

    

82-Which of the following informal example illustrates the concept of repeated execution of the 

statement?    

 As long as there are tickets to sell, keep selling tickets     

 If there are tickets to sell, sell tickets    

 Sell a ticket if there are tickets available     

 Tickets are sold only once    



 

 

83-A translator which takes assembly language program as input  r produce  machine language 

code as output is known as:    

 Interpreter    

 Assembler    

 Debugger    

 Compiler    

    

84- The Sign of modulus is:    

    

 .    

 /    

 % 

  >    

85.  Which one of the following is correct for the symbolic representative of primitives?    

 Abstract    

 Semantic    

 Syntax    

 Systematic    

86- What is the purpose of the program given below?    

if(CGPA>3.0) 

  count<<’Give Scholarship”; 

 Else   

count<<Sorry You do not qualify for the  

Scholarship:”,    

 Providing information about university policies    

 Calculate the CGPA of the Student    

 Determine if a student qualifies for the scholar ship    

 Print a student semester grade    

 

 

 



 

 

87.The set of task that ensure the software is correctly implement a specific function is known as    

 Validation    

 Verification    

 Modularity    

 Requirement gathering     

88 Why is the Therac-25 incident considered a software failure?    

 It occurred in Texas    

 It resulted a man death    

 The software was believed to be correct    

 There was a technical issue in the software    

89. In the declarative paradigm, what does a programmer focus on when presented with a problem?    

 Developing a precise statement of the problem    

 Developing a sequence of command    

 Describes detail algorithms    

 Finding a general purpose Algorithm    

    

    

90-Which is the correct format to find out a value from any given list?    

 Search <>    

 () Search    

 Search ()    

 To search    

91. Which one of the following is the traditional approach of programing process?    

 Object Oriented paradigm    

 Declarative paradigm  Imperative paradigm    

 Functional paradigm    

 

 

92-A program logic written in an ordinary language illustrating a structure similar to computer 

instruction is known as ____    



 

 

 Algorithms    

 Flowcharts    

 Programs    

 Pseudo code    

93- What will be the output of the following statement? int a = 10 + 4.867;    

 14    

 10    

 Computer error    

 14.867    

94-Which Programing Language was developing for scientist and engineering application?    

 Machine Language    

 FORTRAN    

 Assembly Language    

 COBOL    

95.How would you interpret the following pseudo code?    

While (temperature>0):    

 Print (‘Keep warm’)    

Next Instruction    

 Print ‘Keep warm’ if the temperature is greater than to 0    

 Print ‘Keep warm’ if the temperature is less than or equal than to 0    

 Print ‘Keep warm’ until temperature is greater than 0    

 Print ‘Keep warm’ and continue to the instruction    

    

 

 

 

 

 

 

 

96. what is the primary purpose of the pseudo code unit represented by the statement “ def name():?    

    

 to define a loop structure    

 to request the service of the other Units    



 

 

 to announce the title of the Program Unit 

  To print a Message    

97. What is the significance of the term ‘posttest in loop structure?    

 Test for termination best loop execution    

 Continuous testing during loop execution    

 Loop testing perform in parallel     

 Test for termination after loop execution    

98- Reason Behind the Welch NHS IT Failure was    

 Software Security issues    

 weather Conditions    

 Software Technical issue    

 Employees Training    

99. What is the following relates t ‘Origami’?    

 Building construction algorithms    

 Proper folding algorithms    

 Computer algorithms    

 Programing algorithms    

100. Each Programing language tends to approach the parallel processing paradigm and have 

different technology. In ADA we use_________ term for the purpose.    

 Thread    

 task     

 function    

 Method    

 

 

 

101. In the context of the insertion sort algorithm, what is the restriction imposed on 

sorting a list?    

    

 Make a tree of the list to sort entries    

 Sort using the same storage space without extra memory space    

 Insertion sort can only be used on the list containing numeric value   



 

 

  Create A copy of the List to sort items one by one into the new list    

   102. If The condition in the if else structure is false what function will be executed based on the 

following pseudocode example? 

 if(condition):   Processional ()    

Else:    

Reject Application ()   

 

(A)None  

(B)Process loan ()  

(C) Both    

(D)Reject Application) 

  

103. In the following C/C++ Programing what does Z represent?    

Z=X+Y;    

(A)A Variable 

(B) A constant    

(C)A function    

(D)A keyboard    

104. what is the primary focus of pseudo code in the context of algorithm development?    

 Algorithmic Complexity    

 Syntax- Semantic Structure    

 intuitive Notational Systems    

 Formal programing language    

 

 

 

105- Which of the following Symbol is used at the end of the line to separate statement in many 

imperatives language    

(A)*   

(B) ;    
(C)   ,   

(D)  .    



 

 

105. For Sequential Search Algorithm technique, it is________ to be list as sorted in alphabetic order 

in case of names list.    

 Optional    

 Mandatory    

 Sometimes mandatory    

 Not mandatory    

    

   106-Nature of an algorithm is______ because its representation may Change.    

 Tremendous    

 Static    

 Abstract    

 Dynamic    

107-what does the cycle pattern of a loop involve?    

 Ignoring the condition and executing the body    

 Checking the condition only at the end of the loop    

 Executing the body continuously without interruption    

 Repeatedly checking the condition and executing the body    

     

 

 

 

 

 

 

 

108-How many times will the loop in the example below execute? 

 Int counter=1 

  while(counter<=5)    

{    

  Cout<<counter;    

 Counter=counter+2;    

}    

 5 times    

 4 times    

 3 times    



 

 

 6 times    

109- ________ refers data items that can take on only value true or false?    

 Char    

 Float    

 Boolean    

 Int    

    

110- What is the key characteristic of an algorithm according to the formal definition provided in 

the text?    

 Parallel Processing    

 Order and excitability    

 Repetition    

 Ambiguity    

 

 

111-The issue known as _______ might occur if rolling back one transaction affects others and cause a 

(A)chain reaction:  

(B)Cascading rollback  

(C)transaction failure  

(D)deadlock  

(D)transaction inconsistency  

112- A car making factory makes car for their client. In factory design Pattern, Factory is 

considering as:  

(A)Character  

(B)Abstraction  

(C)Instance  

(D)class  

113- Operation that are only partially completed in commercial system might lead to _________ 

information in the database. (A)Valid  

(B)incomplete  

(C)verified  

(D)Accurate  

114-During the implementation phase of software engineering what task is typically performed?  

(A)System analysis  

(B)Requirements gathering  



 

 

(C)writing program  

(D)creating modular design  

115-In a list, what is the opposite end of the head called?  

(A)End  

(B)Tail  

(C)Base  

(D)Bottom  

116-The manufactured product moves into maintenance phase for__________  

(A)Error correction  

(B)repair process  

(C)error removal  

(D)error detection  

117-The binging of a list is called the _________ of the list.  

(A)Devon  

(B)bob  

(C)head  

(D)tail  

 118- what does a tree structure’s hierarchical organization resemble?  

(A)Stack (B)Array  

(C)organization chart  

(D)graph  

119-Triples that have attractive A less than attribute X in relation B are include in the result for the 

condition________  

(A) A.W=B.X  

(B)A.W? >=B.X  
(C)A.W>B.X  
(D)A.W<B.X  

120-How do software engineers often describe the relationship between requirements analysis and 

design?  

(A)Both are focused on what  

(B)requirement Analysis is about how and design is about what  

(C)requirement Analysis is about how and design is about why  

(D)Both are focused on how  

121- What does basis path testing aim to achieve?  

(A)identifying better strategies.  

(B)Applying Efforts in a concentrated area  

(C)Executing each instruction at least once 

(D)identifying equivalence classes.  



 

 

122-In a tree structure, what is the top node called?  

(A)parent node  

(B)Root Node  

(C)Terminal Node  

(D)leaf Node  

123-There we found that a register called a ______ is used to hold the address of the next instruction to be 

executed.  

(A)stack pointer  

(B)program counter  

(C)Data pointer  

(D)timer register  

125- Which of the following is correct option about information hiding in software development.  

(A)Validity of module may not be compromised  

(B)it only depend on internal compositional structure of modules  

(C)it hides all data of program modules  

(D)it prevents unnecessary dependency between modules  

  

126-what is the primary focus of the design phase in software engineering?  

(A)Constructing the software system  

(B)identify problems  

(C)creating a budgeting plan  

(D)Establishing requirements  

127-which organization play a role in improving profession and establishing standards for software quality 

control?  

(A)UNESCO, WHO, and WTO  

(B)ISO,IEEE and ACM  

(C)NATO, IMF and UNICFF  

(D)NASA, NSA and CIA  

128-Accuracy can be archived with the help of testing the result of ___________ in the entire development 

process.  

(A)Every line of code  

(B)Each intermediate step  

(C)last step  

(D)Few Steps  

 

 

 

 



 

 

129-What was the initial focus in the early years of computing regarding software quality?  

(A)Debugging process  

(B)Software Engineering processed  

(C)Certification programs  

(D)Software analysis  

130.  In a tree, what is the term of nodes at the other extreme, often called leaf nodes?  

(A)Terminal Nodes  

(B)Root Nodes  

(C)Internal nodes (D)Parent 

Nodes  

131-which of the Following is the three step software development Process, incorporating testing? 

(A)Requirements analysis and confirmation, design and validation, and implementation and testing  

(B)Requirements analysis, design and implement  

(C)Debugging, Software requirements specification, and implementation  

(D)Debugging, validation, and confirmation  

132-What is the primary Focus of the Design phase in Software engineering?  

(A)Constructing the Software system  

(B)Creating a budgeting plan  

(C)identifying problems  

(D)Establishing requirements  

  

  

133-what is correct benefit of decorator pattern during software development?  

(A)work and combine the modules  

(B)increase software complexity  

(C)it offers standardized way of implementation system  

(D)it designs the hardware of the system  

 

134- The format in which information is displayed by spreadsheet program is similar to the format used in 

the _________  

(A)Hierarchical model  
(B)Relational model  
(C)object- oriented model  

(D)Network model  

 

 

 

 



 

 

135- What is a Stack in the Context of data Structures?  

(A)A list with entries inserted and removed only at the head  

(B)A list with entries removed only at the tail  

(C)A list of sounds recorded on a CD  

(D)A list with entries arranged sequentially  

136-A typically database application involves two major layer the application layer and the 

___________ management layer.  

(A)Scheme  

(B)data base  

(C)user  

(D)data  

137-In a List, what is the opposite end of the head called?  

(A)tail  

(B)Base  

(C)Bottom  

(D)End  

138-The simplest form of array in the _______ array.  

(A)two dimensional  

(B)multi-dimensional  

(C)one dimensional  

(D)all of them   

139-The SELECT operation extracts_____ from a relation.  

(A)A cell  

(B)table  

(C)columns  

(D)rows  

  

  

140-What is an aggregate type in programing?  

(A)Black of data items with different data types  

(B)2- dimensional array  

(C)an integer variable   

(D)rectangular array of numbers  

  

 

 



 

 

141-What is the role of integrated Development Environments (IDEs) in software engineering?  

(A)they hinder collaboration among developers  

(B)They focus solely on project planning  

(C)They provide a single, integrated package for development software  

(D)They eliminate the need for project documentation  

 

151-A ________ is a description of the entire database structure that is used by the database.  

(A)Schema  

(B)subschema  

(C)super schema  

(D)nonschema  

152-_________ is a phase that makes distinction between the task of as software Analyst a programmer:  

(A)Analysis  

(B)testing  

(C)implementation  

(D)design  

153-The node at the top is called ____________ node:  

(A)siblings  

(B)root  

(C)terminal  

(D)head  

154- How do we refers to nodes that have the same parent in a tree?  

(A)Ancestors  

(B)Descendants  

(C)children  

(D)siblings  

155- _________ is the field of engineering that deals with designing system’s interface by considering 

(A)the human physical abilities.  

(B)Thermo dynamics  

(C)Ergonomics  

(D)Cognatic  

  

  

156-What is the approach called when prototypes are discarded in favor of  fresh implementation of the 

final design ?  

(A)Incremental prototyping   

(B)Evolutionary prototyping  

(C)Throwaway prototyping  

(D)Rapid prototyping  



 

 

  

157-Retrieving an employing’s job history in an object- oriented database involves asking them _______  to 

reports its job history .  

(A)Manager  

(B)DBMS  

(C)network  

(D)employee object  

158- ISO/IEC 15504 is a set of stands jointly development by which organization?  

(A)IEEE and IEC  

(B)ISO and IEEE  

(C)ISO and IEC  

(D)ACM and IEC  

159- Which is the significance of computer- Aided software engineering(CASE) tools in the software 

development process?  

(A)They focus solely on theoretical research  

(B)They hinder progress tracking   

(C)They discourage collaboration among teams  

(D)They streams and simply various aspects of development  

  

160-If a transaction request access to an item that is already locked with an exclusive lock____________  

(A)The additional access is denied  

(B)The lock is shared with the requesting transaction  

(C)the transaction us rolled back  

(D)the request is granted immediately  

  

161-Subschemas are crucial in providing________ to different users with in a database.  

(A)similar access  

(B)restricted access  

(C)identical information  

(D)universal access  

 162-What is the primary focus of the maintenance phase in software engineering?  

(A)redesigning the entire system  

(B)repairing software defects  

(C)studying the program  

(D)identifying the bugs in the software  

  



 

 

  

163-The point at which all the steps in a transaction have been recorded in the log is called the____  

(A)Roll back  

(B)commit point  

(C)Schema  

(D)snapshot  

  

164-Which intermodule coupling occurs when a module passes control of execution to another, as in a 

function call?  

(A)Logical coupling  

(B)none of given  

(C)data coupling  

(D)control coupling  

  

165- _____________ is the field of engineering that deals that deals with designing system interface by 

considering the human’s mental abilities.  

(A)genetics  

(B)cognetics  

(C)thermodynamics  

(D)Ergonomics  

  

166- What is the purpose of system documentation?  

(A)explain how to use the software features   

(B)describe the software internal composition for maintenance.  

(C)serve as a marketing tool  

(D)provide information for system installation  

  

167- interior feature of the system can be ignored by the programmer / use the abstraction technique is 

also called_______  

(A)Cohesion  

(B)Coupling  

(C)assembling  

(D)black box  

  

  

  

  



 

 

168-Which phase provides a road map for during project planning?  

(A)Coding  

(B)software Design  

(C)testing  

(D)system analysis  

 

169-The beginning of a list is called_______ of list.  

(A)Tail  

(B)bob  

(C)head  

(D)devon  

  

  

170- Operations that are only partially in completed in commercial system might lead to________ 

information in the databased.  

(A)incomplete  

(B)Verified  

(C)Accurate  

(D)Valid  

 

171- ISO makes software _ for software companies to guarantee control. 

(A)Standards  

(B)software  

(C)queries  

(D)Hardware  

  

172-In a queue, where are entries inserted?  

(A)At the base  

(B)At the tail  

(C)At the top  

(D)At the Head  

  

173- Interior Feature of the system can be ignored by programmer/ user, this abstraction technique is also 

called: 

 (A)Cohesion  
(B)couple  

(C)black box  

(D)Assembling  

  



 

 

174- A module should be designed so that other modules do not need access to its access to internal 

information, this is called:  

(A)Information access  

(B)cohesion  

(C)information hiding  

(D)coupling  

175-How is the depth of a tree defined?  

(A)The number of only first horizontal layer with the tree  

(B)the number of the top nodes in the tree  

(C)the number of nodes from root to leaf in the tree  

(D)the number of only leaf nodes in the tree  

 

176- “The Textbox” command is located in ____________ ribbon in MS Word. 

 (A)insert  
(B)view  

(C)Layout  

(D) Design  

177- The defaulter of MS word documents is:  

(A)paper  

(B)Office  
(C) Flow  

(D)Word  

  

178-  In the insert Tab of Microsoft word where specially where specially is the page group location? 

(A) Fr right  

(B) For left  

(C)Center  

(D) Bottom left  

179- The fifth group in the home ribbon in the: ___________  

(A)Help  

(B)Inserted  

(C) Editing 

 (D) Style  

180- The choose a bulleting or numbering style in MS word, which one of the following option is 

correct?  

(A)By clicking the “Save” Button  

(B) it not possible to change the Style  

(C)You can select the one u prefer to use  
(D) By Applying the “Bold” formatting option  



 

 

 

181- A rapidly subject that is closely associated with databased technology is_________ which consist 

of techniques for discovering pattern in collection of data  

(A) Opening mining  

(B) text mining  

(C) Sentiment analysis  

(D)data mining  
  

182- A file’s _________ is normally stored as a separate file on the same mass storage device as the 

_____.  

(A)Index, indexed file  

(B) flat, flat file  

(C)database, database file  

(D) Sequential, sequential file  

  

  

183- In Microsoft word what is the goal behind placing commands with in groups and table? 

(A) To minimize the number of mouse  
(B) to hide command from users  

(C) to discourage software usages   

(D) to confuse users  

  

184- Which risk category primarily deals with threats like online scamming and identity theft? 

 (A) Contact Risk  

(B) Information Privacy  

(C) Electronic Theft  
(D) Online marketing  

185- In Microsoft Word, which ribbon tab is used to access the hyperlink function?  

(A) Home 

(B)Insert  
(C)Home  

(D)Format  

186-when using style to format a document what advantage it offers?  

  

(A)Advanced editing features  

(B)Faster spell checking  

(C)Consistent application of formatting choices  

(D)Increased document security  

 

 



 

 

187-The conversion from key values to bucket numbers in hashing is done by a hashing 

in done by a _____  
  

(A)Hash Function 

(B)sorting function  
(C)search function  
(D)retrieval function  

188- Each statement in natural language can have:  

(A) Unique Meaning  

(B) Same meaning  

(C) one meaning  

(D)Multiple meaning  

189- what does a formatting style document encompass?  

(A) only paragraph Alignment  

(B) Font name, size, color, paragraph, alignment and spacing  

(C) only sharing and borders  

(D) only font size  

190- In MS word we can set line spacing from group _______  

(A)Clipboard  

(B) insert  

(C)font  

(D)Paragraph  

191- In MS word short cut key of paste is _____  

(A) Ctrl + v  
(B) Ctrl + p  

(C) Alt + v  

(D) Alt +p  

 



 

 

   
193- The classic employee file uses _ to contain information about a single a Single employee in 

the company: 

 (A) records  

(B) keys  

(C)buckets  

(D) hash function  

  

194- generally the Footer feature   is used for presenting _________ in an MS word Documents? 

(A)Paragraph heading  

(B)Picture caption  

(C) page numbers  
(D) Documents body  

  

195-  In context of health computer science have impacts  

(A)Dangerous  

(B)Negative  

(C) Both Positive and Negative  

(D)Positive 

 

 

 

 

 

 

 



 

 

196- How have governments responded to the issue of email spam?  

(A) They Have ignored the problem  

(B)They have increased their own spam emails  

(C) They have encouraged spam activities  

(D)They Have Implemented specific regulations  

197- In Microsoft word, which of the following is Not a category available for page in the page 

group under the insert tab?  

(A)Black Page  

(B)Paragraph page  

(C) Cover Page 

 (D)Page Break  

198- What is the initial Step to inset a picture from a file into word documents? 

(A) Click on shapes  

(B) Click on Pictures in illusions  

(C)Click on Smart Art Button  

(D) click on Cycle in the Left Pane.  

199- ____ begin the paragraph with a large letter that spills down into the text:  

(A)Word art  

(B)text box  

(C) Quick parts  

(D)Drop cap  

  

200- Which feature allows you to write mathematical or scientific formula using insert Ribbon In MS 

Word?  

(A) mathlab  

(B)mathbox 

 (C)Sciencelab  

(D)Equation  

201- When does the Mini Toolbar appear in Microsoft word?  

(A)It appears when You save a document 

 (B) it appear when you open a new document  

(C)it appear when you select text  

(D)it appear when you using word  

202- How can you input text into a table cell in Microsoft Word?  

(A)Click on insert tab and start typing  

(B)Click once on the cell and start typing  

(C) Right click on the cell and Type text  

(D)Double click on the cell and Type text  



 

 

203- The ____________ allows you to save text or Graphics as “Building Blocks” and then call it up 

quickly when u need it.  

(A)Media  

(B) Quick Parts  

(C) text Box  

(D)Equation  

204- In MS word which Group Contain the header and Footer feature?  

(A) Text Group  

(B) page group  

(C)Header & footer group 

 (D) symbol group  

205- Which of the following is often integrated with content filter in the context of the internet? 

(A)Antivirus Software  

(B) Internet Firewalls  
(C) Search Engines  

(D) Email servers  

206- Act that Mandates about financial institute dealing with the private information of individuals 

(A) HPPA  

(B) COPPA  

(C) Gramm-Leach-Billey 

 (D)  FCPA  

207- What are the groups available under the insert tab in Microsoft Word?  

(A)Media, Group, Link Research Group  

(B)pages Group, illustrations Group Index Group  

(C) Page Group, tablets Group Footnotes Group  

(D) Page Group Tables Group, Illustration Group  

208-In MS word we can highlights a text using color from group________  

(A)Clipboard  

(B)Font  
  (C)Insert  

  (D)Paragraph  

  

209-In Microsoft Word What is the Goal Behind placing command with in groups tabs?  

(A) To Discourage software usage  

(B)To hide commands from user  

(C) To confuse user  

(D)To minimize the number of mouse clicks  

 

 

 



 

 

210-In MS word format pointer is in the group of _______  

(A) Clipboard  

(B)Design  

(C)Font  

(D)Insert  

  

211- Which of the following is a famous example of word processing Software?  

(A) MS Access  

(B) MS power Point  

(C)MS word  

(D) MS excel  

  

212- There are many type of sensor including  

(A)All of them  

(B)Camera  

(C) Range sensor  

(D)Microphone  

213- Which of the following is the correct reason why parents choose to use Parental controls on 

digital devices for their children?  

(A)To facilitate late- night phone checking  

(B) To promote responsible and disciplined technology using  

(C) To engage in arguments with their children  

(D) To encourage more screen time  

  

215- Turing test was purposed in:  

(A)1950  

(B)1970 

 (C)1980  

(D)1960  

 216- A ___________ is a file that is accessed in a serial manner from its beginning to its end as though 

the information in the file were arranged in one long row.  

(A)flat file  

(B)index file  

(C) data base  

(D) sequence file  

217-  ________ Begin the paragraph with a large letter spills down into text  

(A) Text Box  

(B) Drop Cap  

(C) Quick Parts 

 (D) Word Art  



 

 

218- In Hash file, the key used to identify an employee’s record is the________  

(A) Departments  

(B)Employee position  

(C)Name   

(D)identification number  

219- Design ribbon can have:  

(A)Page border  

(B)Shapes  

(C)Ward art  

(D)Symbols   

220- Requiring certain degree of uniformity of the style size and orientation of Symbol is a(n): 

(A)Advantage  

(B)Disadvantage  

(C)Ambiguity  

(D)Fast processing  
221-In MS word short cut key of bold is _____  

(A) Ctrl + b  
(B)Ctrl + v  
(C)Click the undo button 
 (D) Alt +p  
222- When editing a documents in MS word what advantage does the find and replace feature 
provide:  
(A) Automatic spell checking  
(B)Auto saving functionality  

(C) Time saving by avoiding manual search 
 (D) Font customization options  
  

223- When we draw a table in MS word the table have initial Colum(s)  

(A) Two  
(B)Zero  
(C)One  
(D)Multiple  
 

225- A device that responds to stimuli from its environment  

(A) Computer  

(B) Agent  
(C) A device  

(D) Router  

225- Page group indicates option:  

(A)Page margins  

(B) Cover page  
(C)Page color  
(D)all of these  



 

 

  

226- A patent can last:  
(A)40 years  

(B) 30 years  

(C) 50 years  

(D)20 years  
 
227- Requiring certain degree of uniformity of the style, size and orientation of symbols is a(n) ( 
A) disadvantage  
(B)Advantage  
(C)Fast processing  
(D)Ambiguity  
228-Information Technology has ___________ overarching standardization in place:  

(A)No  
(B)Old  

(C)Complex  

(D) Multiple  

229- Find option include:  

(A)go to  
(B)find  
(C)advantage find 

 (D) All  
  

230- In Microsoft word what is the purpose of entering a word or phrase while adding a hyperlink:  

(A) Inserting a table  

(B) Displaying the hyperlink text  
(C)Changing font style  
(D)Creating a new paragraph  
231- In Microsoft Word, what is the purpose of the "Go to" command under the Find command?  

(A) To select all text in the document  
(B)to Select text with similar formatting  

(C) To immediately go to a page section o marked location  
(D) to Select hidden shapes behind text  
232- The Arrange Group is placed on the ________ ribbon in MS word.  

(A)Reference  

(B) Review  

(C) Layout  
(D) Home  

233- When does the mini Toolbar appear in Microsoft Word?  

(A)It appears when you save a document  
(B)it appears randomly while using word  
(C)it appears when you pen a new documents 

(D) it appears when you select text  
 



 

 

234- Which feature is not available in the “Text” group under the insert tab in MS word?  

(A)Link   
(B)Date & time  
(C)Signature line  
(D)Object  
  

235- In MS word short cut key to select the whole the txt in a documents is ________  
(A) Alt +w  
(B) Alt +a  

(C)Ctrl + a  
(D) Ctrl + w  
  

 236- 

  

237- What risk involves potential exposure to Inappropriate or un suitable products?  

(A)information Security  
(B)Content Risk  
(C)Contact Risk  
(D)Online marketing  
238- When We Apply header it is shown at:  

(A)End page of document  
(B)Bottom of documents  

(C)every page of documents  
(D) start page of documents  

 

 



 

 

239- What is the significance of the Home ribbon in MS word?  
(A)it contains decorative elements for documents  
(B)it only contains the clipboard group  
(C)it is one of the least ribbons   
(D) it is one of the most important ribbons  
  

240- In Microsoft Word what is the purpose of entering a word a phase while adding a  hyperlink? (A) 

(A)Creating a new paragraph   

(B)Inserting a table  

(C)changing font style  

(D) Displaying the hyperlink text  

241- Which of the following features to add the top margin on the page in MS word?  

(A)Header  
(B)footer  

(C)comments  

(D)text box  

242- In MS word, we have to write an equation with 2 as a number and 3 as its power which option 

is suitable for this purpose? 

(A)Superscript  
(B)Font size  

(C)Case  

(D)Subscript  

243- In Microsoft word 2007, category of illustration allows the inclusion of media files like sound 

and video clips? 

 (A)Clip art  
(B) shapes  

(C) pictures  

(D)canvas  

244- Theoretical track is a part of:  

(A) Amplifying  
(B) Ai domain  
(C) Declarative knowledge 
  (D) Ai response  
245- What are the groups available under the insult tab in Microsoft Word?  

(A) Page group, illustration group index group  

(B) Page Group tables group footnotes group  

(C)Page Group, Tablets Group, illustration Group  
(D)Media Group, Links Group, Research group  

 

 

 



 

 

246- if we want to link two sentence of a same document we generally use:  

(A) Hyperlink  
(B)Cross reference  
(C)Reference  
(D)Bookmark  
  

247-USA has passed legislation allowing The government to actually monitor citizens in the name of: 

(A)National Security  
(B) National ethics  

(C) Data ethics  

(D) Data Security  

248- Electronic Theft include:  
(A) Harmful advice  

(B)Online scam  
(C) unsuitable products (D) 

Cyber bullying  

249- Eye for Long amount of time is not meant to look:  

(A)Continuously  
(B) 2D  
(C) Constantly  
(D) 1D  
250-____________ feature is used to change the font and paragraph properties of the entire 

documents in MS word.  

(A) Symbols  
(B) text Box  
(C) Style Set  
(D) Word Art  
  

251- The amount of paper American use in a year is____________  

(A)83 Million tons  
(B)90 million tons  
(C)95 million tons  
(D)85 million tons  
252- In Microsoft word how can you close the mini Toolbar after you’ve used it?  

(A)Use the ‘AlT + F4” keyboard shortcut  
(B)it automatically closes after you format the text  
(C)Click anywhere outside the mini Toolbar  
(D) Click anywhere outside the mini Toolbar  
 
253- Command that can immediately go to a page or any marked location with your document: 

 (A) go to  
(B) format  

(C)search  

(D)ribbon  



 

 

  

254- The index in an indexed file helps in locating records by ________  

(A) Storing data redundantly  
(B)finding the identify key  
(C)sorting all entries  
(D) arranging records sequentially  
255- A track that leads to a simulation oriented mythology:  

(A)Intelligent  
(B) Proper  
(C) Engineering  
(D)Theoretical  
  
256- In MS word short cut key of Italicize text in MS word _____  
(A) Ctrl + b 

(B) Ctrl + i  
(C)Alt + v  
(D)Alt +p  
257- The field of artificial intelligence is being pursed along path:  

(A)4  
(B)3 

 (C) 2  
(D) 5  
258- In hash file hashing identifies the location of a record of a directly from the_____________  

(A) Key  
(B)Algorithm  
(C) bucket 
 (D)index  
259- What is the goal of using parental controls?  

(A) To promote responsibility and discipline in children  
(B)to exercise authoritarian control  
(C)to encourage excessive screen time  
(D)To make children more disobedient  
260- In MS word, what happen when you click the Cut button in the Clipboard group?  

(A)The text is cut and placed on the clipboard  
(B)The text is formatted  
(C)the text is pasted in the document  
(D)The text is copied to the clipboard  
261- insert tab can have page?  

(A) Styles 

 (B)All of these 

(C) pages  

(D) clipboard  

 

 



 

 

262- In the Context of maintaining employee records, on index is typically used for quick retrieve 

based on_________  

(A) Employee identification number  
(B)Employee’s department  
(C)Employee’s name  
(D)Employee’s date of birth  
  

 263- In MS word which group should the user select to perform the cut operation? 
 (A)Voice  
(B)paragraph  
(C)Style  
(D) Clipboard  
  
264- An index for a file contain a list of _______________ stored in the file.  
(A) directory path  
(B)keys  
(C)data type  
(D)file names  
265- Procedural knowledge is learning:  

(A)”How”  
(B)”When”  
(C)”what”  
(D)”slowly”  
266- Usual way of protecting software is:  

(A) patent  
(B)copy right  
(C)Rules  
(D)company monogram  
  

267-- Access to the forbidden literature is because of:  

(A) Computer  
(B)Identity theft  
(C)Cyber Bullying  
(D) Looking privacy  
268- In Microsoft word what does the quick Access Toolbar Provide easy access to?  
(A)Installed applications  
(B) Frequently used commands  
(C)System setting  
(D) internet browsing  
  

269- processing a sequential file involves detecting when_________ is reached?  

(A)A modification  
(B)A new Record  
(C)The end of the file (EOF)  
(D) The beginning  
  



 

 

270- In MS word, Paragraph group has following option___________  

(A) Text Highlight Color  

(B)Paragraph color  

(C) Shading  
(D)copying  

271- In MS word, which of the following features is not available in the “Text” group of the ”insert” 
ribbon. 
 (A)crop cap  
(B)symbol  
(C) Word Art  
(D)text box  
272- we can add charts in MS word from Group:  

(A)Symbols  
(B)Table  
(C)Illustrations 
(D) Apps  
273- which Tab should you access to manage the overall design and loyal of a table in Microsoft 

Word? 

 (A)Table Layout  
(B) Insert Table  

(C) Table view  

(D)Table Design  

274- The field of linguistic tends towards which direction:  

(A)Engineering  
(B)Ai  
(C)theoretical  
(D) business  

275- In MS word, you can insert text with special styles using the Word Art command 

available in the ______ group of insert Ribbon.  
(A)Design  
(B)Illustration  
(C)styles  
(D) text  
276- The index for a file is usually stored ________  

(A)with the Ram  
(B)As a separate file on the same device  
(C) as a part of the main file  
(D)separately on a different device  
  

 

 

 

 

 



 

 

277- In MS word we can increase the size of text from home ribbon group called_________  

(A)style  
(B) Paragraph  
(C)Clipboard  

(D)font  
  

278- The fifth group in the home ribbon is the:  

(A)Editing  
(B)Help  
(C)Style  
(D)Insert  
279- In MS word different Type of effect on the text can be applied with:  

(A) word art  
(B) quick parts  
(C) All of given  
(D) text Box  
280- In Hash file , of a disproportionate  number of key happen to hash to the same bucket it may 

cause_______ 

 (A) Clustering  
(B) ever distribution  

(C)faster search  

(D) efficient retrieval  

281- What does Microsoft word generally insert a black page automatically?  
(A)when open the documents  
(B)when saving the document 

(C) while typing  
(D) when applying formatting  
282- in Microsoft word which button are part of quick access toolbar by default?  

(A)Save undo, redo/repeat quick print  
(B)Bold Italic underline  
(C)Copy, Paste , cut  
(D) Print close open  
  

283- Which feature is available in the arrange group under the layout in MS word?  
(A)File  
(B)writing  
(C)Arrangement  
(D)Send backward  
  

 

 

 

 

s 



 

 

284- In MS word, what is the Location that is used to Temporary State the information that has been 

cut from somewhere?  

(A) Clipboard  
(B) Drop down menu  

(C)Home tab 

 (D) ROM  

285- In MS word we have paste _______ option (s)  

(A)no  
(B)one  
(C)multiple  
(D)two  
286- What does the expender arrow in the font group do?  

(A) change the font color  

(B) opens the Font Dialog Window  
(C)Underline text  

(D)Increase font size  

287- Act that ranges government on wire taps to include transmission of data is:  

(A) ECPA  
(B) HIPPA  

(C)Gramm-Leach-Billey  

(D)COPPA  

  

288- Which Group of Commands in Microsoft words includes Find, replace, and Select?  
(A)Formatting group 

 (B)Editing group  
(C) Insert group  

(D)View group  

289- From a perspective on entire system in an operating system is like____________  

(A)A fragmented file  
(B) A single large file 
 (C) A randomly arranged file  
(D) one large indexed file  
290- Which of the following significantly increases the chances of fraudulent activity?  

(A) Identity theft  
(B) Gaming addiction  

(C)Cyber bulling 

 (D) Terrorism  

 

 

 

 



 

 

291- Social sites indicates____________  
(A)Twitter  
(B)goggle  
(C)Bing  
(D)All of these  
292- Which of the following commands is available in the drop down menu of the Wrap text feature in 

MS word  

A: top and bottom  B: Behind Text  C: in front of Text  

 

(A)A and B  
(B)A, B and C  
(C)A only  
(D) B and C  
  
293- One way to identify the ECF is by Placing a special record known as a _______ at the end of the 

file.  

(A) Marker  

(B) Terminator  

(C)Pointer  
(D) Sentinel  
294- What is the primary purpose of content filtering in Firewall?  

(A)Enhancing access to all content  

(B) Allowing access to harmful items  

(C)Maintain anonymity of local machine  

(D)Preventing access to harmful item  
295- Which one of the following acts as a security guard between the internet and your local area 

network?  

(A) System security  
(B) Firewall  
(C)Internet  
(D) Network Security  
296- Can-Spam act applies in:  

(A)UK  
(B) UAE  
(C)Canada 

 (D)US  
  
297- The style group in the home ribbon in this  

(A) fifth group  
(B)fourth group  
(C) Second group  
(D)  third group  
 

 

 

298- Displaying text in two Columns feature in which Tap of MS word?  



 

 

(A) Review  
(B)Design  
(C)Insert  
(D) Page Layout  
 
299- In Microsoft Word which feature allows you to change a specific word or phrase throughout the 
entire document effortlessly?                                                                                                                             
(A)Find and replace  
(B) Spell check  

(C) Format Pointer  

(D) Select All  

300- In Microsoft word which group under the insert tab is primarily used  to create links with the 

documents or to external source?  

(A) text 

 (B) page 

(C)links  

(D)symbols  

301- A mark or any other distinctive sign associated with production is called:  

(A)Trademark  
(B)Copyright  
(C)company monogram  
(D)patent  
301- Computer security is also known as ______________ 

(A)copyright  

(B)cyber security  
(C) Firewall security  

(D) Privacy  

302- Data mining is practiced on __________ data collection called data ware houses.  
(A)forceful  
(B)dynamic  
(C) vibrant  

(D)static  
303- People are working in sitting due to computer and thus have more chance to develop____  
(A) thinking  
(B) Obesity  
(C) creativity  
(D)Harmful Habits  

304-nformation that was once buried in arcane records has become accessible because of?  

 (A)Database  

 (B)Online management   

(C)Artificial intelligence 

 (D)Computer   



 

 

305-What actions or functionalities are triggered when the "Insert Table" option located 

within the Insert tab is clicked?  

(A)A new table is inserted at the current cursor position.  
(B)A dialog box appears asking for table dimensions.  
(C)A table design window opens for customization.  
 (D)The document closes without saving changes.   
  

306- AI is helping to make:  

 (A)Smartphones   
(B)Online education  
 (C)Robots   
(D)DBMS  
  

307-In Microsoft Word, what does the user need to click to access the Numbering Library?  

(A)Numbering button   

(B)Numbering tab   

(C)Paragraph tab  

 (D)Numbering group  

  

308-Which tab should you access to manage the overall design and layout of a table in 

Microsoft Word?   

(A)Table Layout  

 (B)Insert Table  

 (C)Table Design  

 (D)Table view  

  

309-A styles option includes font  

 (A)Color   

(B)Name  

 (C)Size  

 (D)All of these  

  

310-One method that got on social media is the idea of a parent/child cell phone  

(A)Contract  

 (B)Privacy  

 (C)Limitation  

 (D)Usage  

  

 

 

 



 

 

311- Copyright can be applied on:   

(A)Artistic work   

(B)All of these   

(C)Music  

 (D)Dramatic works  

312-Which of the following is a robot used in medical field:   

(A)Belgian robot  
(B)MED robot   
(C)TUG robot   
(D)Smart Doc  
 

 313-What is the primary purpose of the Styles group in Microsoft Word?  

 (A)Inserting images  

(B)Creating tables  

(C)Applying formatting options to text 

 (D) Spell checking  

314-Which feature of MS Word offers to create special effects like adding artistic flair to a 

text"?  

 (A)SmartArt  

 (B)Drop Cap  

 (C)WordArt  

 (D)Text Box  

315-In Microsoft Word, what function does the Blank Page option in the Insert tab serve?  

(A)Insert a table.   

(B)Add a new page anywhere in the document.   

(C)Create a cover page.  

 (D)Insert a header/footer.  

316-Matching geometric characteristics technique of recognizing images is used in: .  

 (A)Optical character recognition  

 (B)Sorting pictures  

 (C)Mark recognition   

(D)Taking pictures  

317- ________ are ideal for storing data that will be processed in the order in which the file’s entries 
are stored.   
(A)Index files  
(B)Sequential files  
(C)Flat files  



 

 

(D)Database files  
   

318-________ are ideal for storing data that will be processed in the order in which the file’s 

which part of the world, spam-law requirements are generally less strict?  

(A)Australia  
(B)Africa, Asia, and South America  
(C)North America 
 (D)Europe  

319-Meaning of a statement in natural language depends on its: .Choose the right answer:  

(A)Grammar  
(B)Formatting  
(C)Style  
(D)Context   
  

320-In Microsoft Word, how can you access the table option in Microsoft Word?  

(A)Home tab > Tables group  
(B)Layout tab > Tables group  
(C)References tab > Tables group  
(D)Insert tab > Tables group  
 

321-Which of the following significantly increases the chances of fraudulent activity?  

 (A)Gaming addiction  
(B)Cyber bullying  
(C)Identity theft  
(D)Terrorism  
 
 



 

 

-  
322- Correct Answer is C: Debugging process 
  

 

 

 
  323- Correct Answer is C: They Streamline and simplify various aspects of development 



 

 

 
 324- Correct Answer is B: Data Storage 



 

 

 

 325-Correct answer is B: A pre-developed model for solving recurring software problem 



 

 

 

 326- Correct answer is D: Software Design            

 

327- Array is ___________ 

(A) one dimensional  

(B) two dimensional  

(C) three dimensional  

(D) four dimensional  

 



 

 

 
 

  328- Correct Answer is D: Unintentional interactions 



 

 

 

       329- Correct Answer is C:   Design production, installation and serving  

 



 

 

 

330- Correct Answer is A: Each intermediate step 



 

 

 

331- Correct Answer is D: Pair of Indices 



 

 

 

                            332- Correct Answer is B:  Software Design 



 

 

 

333-  Correct Answer is B:       Rows 



 

 

 

 334- Correct Answer is D: Smartphone interface 

 

 



 

 

 
335- Correct Answer is D:  Be forced to wait if the item is already exclusively 

locked 

 



 

 

 
  336- Correct Answer is C: Design Pattern  
 



 

 

 
337- Correct Answer is D:  IDE’s 

 



 

 

338- Correct Answer is D: It insisted on a sequential completion of all 

Phases 

 



 

 

 

    339- Correct Answer is C:   Waterfall 



 

 

 
340- Correct Answer is C:  How 

 



 

 

 
       341-Correct Answer is C:   Traditional architecture 

 
 



 

 

 

342- Correct Answer is C: Organization Chart 
 



 

 

 
343- Correct Answer is A: Requirement analysis is about what, and design 

is about how 
 



 

 

344- Correct Answer is B: “Repeated cycles of analysis, design, 

implementation and testing” 

 



 

 

 
345- Correct Answer is A:   “ Using a Comma” 
 



 

 

 
            346- Correct Answer is B: Declaration, allocation and manipulation 

of data 
 



 

 

 
347- Correct Answer is C: Wound wait 

 

 
348- Correct Answer is A: Saved after Program termination 



 

 

 
349- Correct Answer is B:  Writing programs and creating data files 
 



 

 

 
350- Correct Answer is C:  Errors occur during module development 

 

 
 

351- Correct Answer is A: to Eliminate the need for testing 



 

 

  

352- Correct Answer is C: Writing Program 

 
 

 



 

 

 
 

353-Correct Answer is B:  Class 

 

 



 

 

 
 

354- Correct Answer is C: Human Behaviors  
 

 



 

 

 
355- Correct Answer is B:  Rectangular 

 



 

 

 

356- Correct Answer is A: Standards 
 

 

 



 

 

 
 

357- Correct Answer is B: Schemas, Subschemas 

 

 

 



 

 

 
 

358-Correct Answer is B: The Strict one – directional flow of the development 

process 

 

 



 

 

 
 

359-  Correct Answer is A: Field Names 

 



 

 

 
 

360-Correct Answer is C: Instruction pointer 

 



 

 

 
361- Correct Answer is A: Pointer 

 



 

 

 
 

362- Correct Answer is D: It offers standardized way of implement system 

 

 
363- Correct Answer is D: Linus Torvalds 

 



 

 

 
364- Correct Answer is C: Tracking alphabet letters occurrences 

 



 

 

 
 

365- Correct Answer is C: Software Development Life Cycle 

 



 

 

 
365- Correct Answer is C: Tree 

 

 
 

366- Correct Answer is C: Software Life Cycle 

 



 

 

 
367- Correct Answer is D: Integrating 

 



 

 

 
 

368- Correct Answer is D: Patent Law  

 



 

 

 
369- Correct Answer is B: Single row of elements  

 



 

 

 
 

370- Correct Answer is C: Constructing the Software system 

 



 

 

 
371- Correct Answer is A: Siblings 

 



 

 

 
 

372- Correct Answer is D: Approving software requirements Specification 

 

 
373- Correct Answer is D: Maintain Validity and Integrity of System 



 

 

 
 

374- Correct Answer is A: Standard Template Library 

 

 
 

375- Correct Answer is B: Similarity 



 

 

 
`376- Correct Answer is A: information hiding 

 

 
377- Correct Answer is C: Data independence 

 



 

 

 
378- Correct Answer is C:  Repair Process 

 



 

 

 
379- Correct Answer is B:   Instance 



 

 

 
380- Correct Answer is C: Software life Cycle 

 



 

 

 
 

381- Correct Answer is C: Graph Theory 

 



 

 

 
382- Correct Answer is D: Internal Binding 

 



 

 

 
383- Correct Answer is A: Incorrect summary problem 

 

 
384- Correct Answer is C: to evaluate the incomplete version of the propsed 

system 



 

 

 
 

385- Correct Answer is C: IBM 



 

 

 
386- Correct Answer is A: A pre-developed model for solving recurring software 

problem 

 



 

 

 
387- Correct Answer is C: Relation 

 

 
388- Correct Answer is D:  Introduction of more problem  

 



 

 

 
389- Correct Answer is A: Rectangles   

 



 

 

 
390- Correct Answer is B: Repairing software defects 

 



 

 

 
391- Correct Answer is B: Lost update problem 



 

 

 
 

392- Correct Answer is C: The number of nodes from root to leaf in tree 

 



 

 

 
393- Correct Answer is C: Deciding what the software system is to do 



 

 

 
 

394- Correct Answer is A: Relational Model 

 

 
395- Correct Answer is C: tuple, tuple 



 

 

 
396- Correct Answer is B: Poor communication and changing requirements 

 

 
397- Correct Answer is B: database 



 

 

 
398- Correct Answer is C: Designing systems that harmonize with Physical 

abilities of human 



 

 

 

 
399- Correct Answer is A: Functional Cohesion 



 

 

 
400- Correct Answer is D:  Error Correction 

 



 

 

 
401- Correct Answer is B: Breaking down a project into smaller components 



 

 

 
402- Correct Answer is D: Top 

 



 

 

 
403- Correct Answer is D: Large database 



 

 

 
404- Correct Answer is D: Row associated with position 



 

 

 
405- Correct Answer is A: To simplify the software maintenance process 

 

 
406- Correct Answer is A: Objects 

 



 

 

 
407- Correct Answer is C: Inheritance 

 

 
407- Correct Answer is A: To facilitate user 

 



 

 

 
408- Correct Answer is C: Entries are removed in the reverse order of storage 

 



 

 

 
409- Correct Answer is D: Programmers are primarily involved in the 

implementation step 

 

 
410- Correct Answer is A: Confirming Software product with the software 

requirements specification 



 

 

411-How to create an Unordered list in HTML? 

Select the correct option 

(A)<ul> 

(B)<ol> 

(C)<href> 

(D)<b> 

 

412- in Dreamweaver, we need to go to the _______ to insert an image in HTML 

page, in Dreamweaver. 
 
(A)Format Tab 
(B)Insert tab 
(C)Command tab 
(D)Edit tab 

 

413-What is the function of the HTML style attribute? 
(A)It is used to uniquely identify some specific styles of some element. 
(B)None of the above. 
(C)It is used to add styles to an HTML element. 
(D)Both 1 and 2. 
 
414- What are the attributes used to change the size of an image? 
  
(A)Top and bottom 
(B)Width and height 
(C)None of the above 
(D)Big and Small 
 
415-What tag is used to display an image on a webpage? 
(A)None of the above 
(B)<src> 
(C)<img> 
(D)<image> 
 
416-Use the Unordered List button in the Property Inspector to create _______  
(A)Numbered List 
(B)a bulleted list 
(C)Sequential numbers List 
(D)None of the above 
 
 
 
 



 

 

416-What is the use of the <b> tag? 
(A)It is used to change the font size. 
(B)None of the above. 
(C)It is used to write black-colored font. 
(D)It converts the text within it to bold font. 
 
417-How to create an ordered list in HTML? 
(A)<ol> 
(B)<ul> 
(C)<b> 
(D)<href> 
 
418-To insert the table, we need to go to the 
(A)Modify tab 
(B)Insert tab 
(C)Edit tab 
(D)Format tab 
 
419-HTML tags can be written within? 
(A){ } 
(B)! ! 
(C)< > 
(D)None of the above 
 
420-Which of the following tags don’t require a closing tag? 
(A)<br> 
(B)None of the above 
(C)<hr> 
(D)Both 1 and 2 
 
421- A web page can be written using the following editor 
(A)None of the above 
(B)Dreamweaver 
(C)Both 1 and 2 
(D)Notepad 
 
422-HTML editors can work with the following 
 
(A)XML 
(B)CSS 
(C)All of the Above 
(D)HTML 
 
423-The text between tags ___________ is presented as a first heading. 
(A)<heading> and </heading> 
(B)<head> and </head> 
(C)<h> and </h> 
(D)<h1> and </h1> 



 

 

424-The text between tags ___________ describes the start and end of the web page. 
 
(A)<title> and </title> 
(B)<html> and </html> 
(C)<head> and </head> 
(D)<body> and </body> 
 
425- WYSIWYG stands for_________ 
(A)None of the Above 
(B)What You See Is What You Get 
(C)When You Start Is When You Go 
(D)What You See Is What You Gain 
 
426-Web page documents have the file extension …. 
(A).obj 
(B).html 
(C).class 
(D).cpp 
 
427- HTML stands for:___________ 
  
(A)Hypertext Markup Language 
(B)None of these 
(C)Hypertext Markup Links 
(D)High Text Machine Language 
 
428-Elements such as tables, queries, forms and reports in a database are called ______ 
  
(A)Objects 
(B)Datasheets 
(C)Data types 
(D)Records 
 
429-How many basic types of queries are used to manipulate the databases____ 
(A)3 
(B)2 
(C)4 
(D)None of the Above 
 
430-An Access database object that is used to enter, view or edit records 
(A)Report 
(B)Form 
(C)Table 
(D)Query 
 
 
 
 



 

 

431-ool that allows users to manage, store, retrieve and analyze the information. _________ 
(A)Record 
(B)Database management system (DBMS) 
(C)Query 
(D)Field 
 
432-Which of the following Microsoft Office tool is used to create database_______ 
(A)Microsoft Access 
(B)Microsoft Word 
(C)Microsoft Excel 
(D)Microsoft PowerPoint 
 
433-Press _____ to quit MS Access.  
(A)Esc+ W 
(B)Ctrl +F4 
(C)Tab +F4 
(D)Alt+F4 
 
435-Which of the following is not a type of Microsoft Access database object? 
(A)Form 
(B)Table 
(C)Modules 
(D)Worksheets 
 
436-Each column in the table is referred to as a____________ 
(A)None of the above 
(B)Tuple 
(C)Field 
(D)Record 
 
437-________ Tab helps you to provide a quick and easy way to create tables, forms, reports and 
queries. 
 
(A)External Data 
(B)Datasheet 
(C)Database Tools 
(D)Create 
 
438-SQL is used for ……… 
 
 (A)Creating Front End of websites 
(B)Creating Web Pages 
(C)Accessing databases 
(D)None of these 
 
 
 
 



 

 

439-In order to access and retrieve data from the database we use 
(A)CSS 
(B)SQL 
(C)XML 
(D)HTML 
 
440-________ Tab is used to import, export, collect and share data between different databases. 
 
 (A)Datasheet 
(B)External Data 
(C)Create 
(D)Database Tools 
 
441-What is the full form of SQL? 
(A)Simple Query Language 
(B)Structured Query Linear 
(C)Straight Query Language 
(D)Structured Query Language 
 
442-Organized collection of data or information that can be accessed, updated, and managed is called 
_______ 
(A)None of the above 
(B)DBMS 
(C)File 
(D)Database 

  

443-How many types of sorting techniques are available in MS Excel? 

(A)One 

(B)Two 

(C)Three 

 

444- ________ allows you to manipulate data in a worksheet based on a given set 

of criteria. 

(A)Sorting and Filtering 

(B)Formatting 

 

445-You can sort the data in 

(A)Both C and D 

(B)None of the above 

(C)Descending order 

(D)Ascending order 

 



 

 

446-n Microsoft Excel, Sort & Filter button can be found in ________. 

(A)Home tab 

(B)Formula tab 

(C)Insert tab 

(D)Review tab 

 

447-…………. of data lets you hide unimportant data and show only that data 

you’re interested in. 

(A)Sorting 

(B)Restricting 

(C)Alignment 

(D)Filtering 

 

448-The process of arranging the data in ascending and descending order is 

known as ……... 

(A)Filtering 

(B)Restricting 

(C)Sorting 

(D)Alignment 

 

449_In MS Excel two or more cells can be combined to create a new, single and 

larger cell by using ............. option. 

(A)Wrap 

(B)Merge 

(C)Filter 

(D)Pivot 

 

450-The ________ feature of MS Excel quickly completes a series of data  

(A)Auto Complete 

(B)Auto Fill 

(C)Sorting 

(D)Fill Handle 

 

 

 



 

 

451- Which of the following identifies a cell in Excel?  

(A)Formula 

(B)Address 

(C)Label 

(D)Name 

 

452-In MS Excel, charts can be inserted from ........... tab 

(A)Formula 

(B)Insert 

(C)Data 

(D)Home 

 

453-What is the formula to find Finds the minimum value within a range 

(A)Minimum 

(B)Lowest 

(C)Min 

(D)Low 

 

454-353-What is the formula to find SUM in MS excel ? 

(A)=Minimum 

(B)=SUM 

(C) +SUM 

(D) /SUM 

 

455-In MS Excel which function is used to count the number of cells in a 

specified range. 

(A)Count 

(B)Sum 

(C)Average 

(D)Max 

 

 

 

 

 



 

 

456-_______ enable Graphical representation of the data in Excel 

(A)Equation 

(B)Smart Art 

(C)Charts 

(D) Table 

 

457-The area which falls at the intersection of a column and a row is known as: 

(A)Cell 

(B)Formula Bar 

(C)Ribbon 

(D)Name Box 

 

458-______ is an electronic spreadsheet application that enables users to store, 

organize, calculate and manipulate the data.  

(A)Microsoft Excel 

(B)Microsoft PowerPoint 

(C)Microsoft Access 

(D)Microsoft Word 

 

459-Which of the following fill effects can be used to fill the background of the 

slide? 

(A)Gradient 

(B)Texture 

(C)Picture 

(C)All of the above 

 

460-In a presentation of PowerPoint, the special effects used to introduce slides 

are known as ________________  

(A)Transitions 

(B)None of the above 

(C)Custom Animation 

(D)Annotations 

 

 



 

 

461-In PowerPoint, the objects on the slide used to hold the text are called as 

______________ 

(A)Textbox 

(B)Text holders 

(C)None of the above 

(D)Placeholders 

 

462-What happens if you select first and second slide and then click on New 

Slide button on toolbar? 

(A)A new slide is inserted as third slide in presentation 

(B)None of above 

(C)A new slide is inserted as first slide in presentation 

(D)A new slide is inserted as second slide in presentation 

 

463-What are the three options available in Insert >> Picture menu in Power 

Point? 

(A)Clipart, Pictures, Shapes 

(B)Clipart, Pictures, AutoShapes 

(C)Clipart, From Files, AutoShapes 

(D)Clipart, From File, Shapes 

 

464-Which of the following file format can be added to a PowerPoint show? 

 (A).jpg 

(B).wav 

(C).gif 

(D)All of these 

 

465-In which bar we can see the current position of the slide? 

(A)Ribbon 

(B)Status bar 

(C)Title bar 

(D)View option bar 

 

 

 



 

 

466-The minimum zoom size in MS PowerPoint is ____ 

 (A)100 

(B)10 

(C)30 

(D)0 

 

467- What’s the best way to design the layout for your slides?  

(A)Create layouts for slides, handouts and notes using the Master Layout dialog 

box in slide master view 

(B)Apply templates from the Slide Design task pane 

(C)None of above 

(D)For each new slide, select a layout from the Slide Layout task pane 

 

468- Which of the following is the default page set-up orientation for notes 

pages, outlines and handouts? 

(A)Landscape 

(B)All of these 

(C)Portrait 

(D)Vertical 

 

469-In slide layout panel, how many layouts are available for text layout by 

default? 

 (A)7 

(B)1 

(C)4 

(D)12 

 

470-Which type of view is not present in MS PowerPoint? 

(A)Slide sorter 

(B)Slide show 

(C)Extreme animation  

(D)Normal 

 

471-What is the default PowerPoint standard layout? 

(A)Title slide 



 

 

(B)Title only 

(C)Comparison 

(D)Blank 

 

472-Which command will you use in PowerPoint if you need to change the color 

of different objects without changing content? 

(A)Color Scheme 

(B)Object Color 

(C)Design Template 

(D)Font Color 

 

473- Which feature is not in MS PowerPoint?  

(A)Background color 

(B)Zoom 

(C)Slide show 

(D)Scan a virus 

 

474- Which PowerPoint view displays each slide of the presentation as a 

thumbnail and is useful for rearranging slides? 

(A)Slide Sorter 

(B)Notes Page 

(C)Slide Master 

(D)Slide Show 

 

475- Which is not the valid edition of MS PowerPoint? 

(A) MS PowerPoint 2010 

(B) MS PowerPoint 2003 

(C)MS PowerPoint 2007 

(D)MS PowerPoint 1920 

 

 

 

 

 

 



 

 

476- The PowerPoint view that displays only text (title and bullets) is 

____________ 

(A)Slide show 

(B)Notes page view 

(C)Slide sorter 

(D)Outline view 

 

477- n PowerPoint, the header and footer button can be found on the insert tab 

in what group? 

(A)Object group 

(B)Text group 

(C)Tables group 

(D)Illustrations group 

 

478- In MS-Word ruler helps_______________? 

(A)all of the above 

(B)to set indents 

(C)to change page margins 

(D)to set tabs 

 

479- Which of the following provides a list of synonyms? 

(A)Replace Command 

(B)Thesaurus 

(C)Find Command 

(D)Spelling and Grammar 

 

480- Suppose you are asked to review the corrections made using the Track 

Change function by your supervisor, however, the changes are not visible.  How 

can you view the changes he made? 

(A)You can view the changes by changing the Display for Review value to All 

Markup. 

(B)There are no track changes made to this document. 

(C)You can view the changes by selecting Show Markup in the Tracking group. 

(D)You can view the changes by switching on track changes by clicking on the 

Track Changes button in the Tracking group. 



 

 

481- The ribbon in Word 2007 consists of a series of? 

(A)Gates 

(B)Icons 

(C)Tabs 

(D)Smaller ribbons 

 

482- What action do you need to take to switch off track changes? 

(A)Under the Review tab on the Ribbon, in the Changes group, click on the Accept 

button to switch track changes off. 

 

(B)None of the options listed above are correct. 

 

(C)Under the Review tab on the Ribbon, in the Tracking group, click on the Track 

Changes button to switch track changes off. 

 

(D)Under the Review tab on the Ribbon, in the Tracking group, click on the Show 

Markup button to switch track changes off. 

 

483- How can you easily and consistently navigate between track changes in a 

document? 
(A)Use the scrolling wheel on your mouse and look out for changes made in red in a document. 

(B)Click on the Show Markup button in the Tracking group to navigate between track changes in a 

document. 

(C)All of the options listed above are correct. 

(D)In the Changes group, use the Previous and Next buttons to navigate between track changes in a 

document. 

 

 

 

 

484- To block another user from switching off track changes in a document, 

what function should you enable? 
(A)All of the options listed above are correct. 
(B)No function is necessary, once Track Changes is switched on, they cannot be stopped unless all 
changes are accepted. 
(C)The Lock Tracking option, which is located under the Track Changes button, will discourage users 
from switching off track changes. 



 

 

(D)Activate the Reviewing Pane in the Tracking group. This will prevent other users from switching off 
the track changes function. 

 

485- How can you easily and consistently navigate between track changes in a 

document? 
(A)In the Changes group, use the Previous and Next buttons to navigate between track changes in a 

document. 
(B) Click on the Show Markup button in the Tracking group to navigate between track changes in a 
document. 
(C)Use the scrolling wheel on your mouse and look out for changes made in red in a document. 
(D)All of the options listed above are correct. 
 
486- How do you permanently apply all the edits that were made in track changes, to a document? 
(A)Right-click the document and select Apply Track Changes and Stop Tracking from the list to accept all 
the changes in a document. 
(B)Click on the dropdown arrow below the Accept button in the Changes group and select Accept All 
Changes. 
(C)Click on the Track Changes button in the Tracking group to accept all changes in a document and to 
stop tracking changes. 
(D)In the Display for Review box in the Tracking group, select No Markup to accept all the changes in a 
document. 
 
487- What action do you need to take to switch off track changes?  
(A)Under the Review tab on the Ribbon, in the Tracking group, click on the Track Changes button to 
switch track changes off. 
(B)None of the options listed above are correct. 
(C)Under the Review tab on the Ribbon, in the Tracking group, click on the Show Markup button to 
switch track changes off. 
(D)Under the Review tab on the Ribbon, in the Changes group, click on the Accept button to switch track 
changes off. 

 

488- To block another user from switching off track changes in a document, 

what function should you enable? 

(A)Activate the Reviewing Pane in the Tracking group. This will prevent other 

users from switching off the track changes function. 

(B)No function is necessary, once Track Changes is switched on, they cannot be 

stopped unless all changes are accepted. 

(C)All of the options listed above are correct. 

(D)The Lock Tracking option, which is located under the Track Changes button, 

will discourage users from switching off track changes. 



 

 

 

489- Which Command Inserts a comment at the active cell?  

(A) (Shift + F3) 

(B) (Shift + F2) 

(C) (Shift + F4) 

(D) (Ctrl + F2) 

 

490- You realized you made an error while creating your document. You used 

the word “maroon” instead of “burgundy” in several places. What is the 

quickest way for you to correct your mistake? 

 

(A)Click Ignore in the Spell Check and retype them manually. 

(B)Use the Cut and Paste feature. 

(C)Use the Find and Replace feature. 

(D)Use the Copy and Paste feature. 

 

491- ____________ are advanced features that can speed up editing or 

formatting you may perform often in a word document. 

(A)Macros 

(B)Comment 

(C)Ribbon 

D)Track changes 

 

492- You have just completed your first novel. It's perfect but the publisher still 

wants their editor to check it over and make any necessary corrections. You 

reluctantly agree but you want final say over any changes. "Grammar is more of 

an art than a science", you argue. But how can you review the editor's changes 

in a 1500-page novel without missing any of those changes? 

  

(A)Word count 

(B)Find and replace 

(C)Quick parts 

(D)Track changes 

 

 



 

 

493- How can you quickly delete ALL the comments made within a document at 

once? 

  

(A)Right-click on each comment within the document and select Delete 

Comment from the list. 

(B)Under the Review tab on the Ribbon, in the Comments group, select Delete 

and then Delete All Comments in Document. 

(C)Click on Select All Comments under the Review tab on the ribbon and press the 

Delete button on your keyboard. 

(D)All of the options listed above are correct. 

 

494- You realized you made an error while creating your document. You used 

the word “maroon” instead of “burgundy” in several places. What is the 

quickest way for you to correct your mistake? 

(A)Use the Find and Replace feature. 

(B)Click Ignore in the Spell Check and retype them manually. 

(C)Use the Copy and Paste feature. 

(D)Use the Cut and Paste feature. 

 

495- Which would you choose to list Synonyms & Antonyms of a selected word? 

(A) Insert, Cross-reference 

(B)Tools, Options 

(C)Tools, Spelling & Grammar 

(D)Tools, Language 

 

496- Which of the following drop down contains the commands: Set Proofing 

Language and Language Preferences. 

 (A)Word Count 

(B)Translate 

(C)Language 

(D)Thesaurus 

 

 

 

 



 

 

497- Which of the following does not belong to Translate command in MS Word? 

(A)Mini Translator 

(B)Spell Check 

(C)Translate Selected Text 

(D)Translate Document 

 

498-Which of the following commands is present in the Review tab? 

(A)Tracking 

(B)All of the above 

(C)Proofing 

(D)Comments 

 

499- What is the name of the feature that allows us to take a step backward if 

we've made a mistake? 

(A)Redo 

(B)Cancel 

(C)Undo 

(D)Backspace 

 

500- the _____________ feature in Word automatically corrects certain spelling, 

typing, and capitalization or grammar errors. 

(A)AutoCorrect 

(B)Auto Fix 

(C)AutoMark 

(D)Auto Spell 

 

501- How many margins are surrounded around the document page? 

(A)Four (center, top, left and bottom) 

(B)Two (landscape and portrait) 

(C)Four (top, bottom, right and left) 

(D)Two (header and footer) 

 

 

 



 

 

 

502-Why are headers and footers used in documents?  

(A)To mark large document more readable 

(B)To mark the starting and ending of a page 
(C)To allow page headers and footers to appear on a document when it is printed. 

(D)To enhance the overall appearance of the document 

 

503-Which item is printed at the bottom of each page 

(A)Footer 

(B)Footnote 

(C)Title 

 

504-What item contains detailed information about something in the text? 

(A)Header 

(B)Head Note 

(C)Footer 

(D)Footnote 

 

505-Where does Word insert a table of contents? 

(A)After the cover page 

(B)At the insertion point 

(C)On the first page of the report 

(D)Before the document title 

 

506- Where footnotes appear in a document? 

(A)None 

(B)End of document 

(C)End of Heading 

(D)Bottom of a Page 

 

 

 

506- A bookmark is an item or location in a document that you identify a name 

for future Reference. Which of the following tasks is accomplished by using 

bookmarks? 



 

 

(A)To add hyperlinks in a web page 

(B)To mark the ending of a page of document 

(C)None of These 

(D)To quickly jump to a specific location in the document 
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